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From The Chief Editor's Desk
 
 


Isn't it strange how some people come into your life just when you need them the most? We may not always realize it at the time. Sometimes, we may even be a bit reluctant to open the door for them to come in. But some people are so persistent, there simply is no telling them "No." Closed doors are no obstacle, either. They just keep knocking until the door is answered. They'll even find a way to force their way in, if you don't open the door.


I once had a friend just like that.

 

 


Me, with my wife, Laura.
 


I guess I should back up a bit. There is a bit of a "backstory" here, and I need to fill in some gaps for this all to make sense. Back in the 1990s, I had just been through a divorce with my second wife. The "girlfriend" after my second divorce took advantage of me, financially. Between the bills I "inherited" from my second wife, coupled with the financial shellacking of the girlfriend, I was in a bad, bad place. I often wondered how I'd afford my next meal. I worked full time, and still just barely managed to keep a roof over my head, and just barely kept my aging vehicle road worthy.


During that same time, I was a small time Windows Shareware programmer and author. I wrote and distributed MiniHelp Plus, a help authoring program and system for the old RTF-based Windows Help system, more affectionately known as Winhelp. Most of what I did, programming wise, centered around the Windows Help subsystem. One aspect of that was seeing how far I could "push" Winhelp to do things it really never was intended to do. Ralph Walden, the Winhelp project lead at Microsoft at that time, had the foresight to make Winhelp extensible with specially designed dynamic linked libraries, or DLLs. To that end, I was also the programmer/author of Arsenal.dll. It had a literal arsenal of tools that allowed the display of true color images (native Winhelp support for images was limited to a 16 color palette ... you could display whatever color you wanted, just so long as it ONLY included those 16 colors), video playback, audio playback, and a whole host of other "delights" that typically weren't available within the RTF-based Winhelp. Hence, its name ... Arsenal.dll.


Email didn't play as "big" of a role then, as it does now. It wasn't as easy to find someone as it is now. The internet, compared to what it is today, was in its infancy. BBS systems were waning, Usenet newsgroups were THE thing, AltaVista and Yahoo competed for the top spot among web search engines, and IRC was still king of the online chat. Online "people searches" hadn't really been organized into the big business that it is today. But, to my friend, none of that deterred her. She set out to find me, and failure was not one of her options.


One day, out of the blue, I got a phone call. It was from a phone number and name I did not recognize. After having been bombarded endlessly by creditors I was unable to pay their desired payments, I remember almost not answering the phone. At first reluctant and thinking it was yet another creditor, I relented and answered the phone. Without much delay, the very well spoken and kind lady on the other end established if I was, indeed, the programmer/author of Arsenal.dll. I confirmed that I was that person. Like a racehorse out of the gate, an immediate friendship was born.


She went on to detail her pet project, Vacation Alaska (now defunct). It was an electronic publishing attempt when most people hadn't even heard of -- or considered -- electronic publishing. She was looking to move it from its DOS based roots, to the more robust Winhelp. Arsenal.dll helped her overcome some of the inherent limitations of the standard Winhelp, making it her first choice as the new destination platform. Two people talking about something they had in common: a passion for using Winhelp as an electronic publishing platform


That phone call couldn't have come at a better time, during one of the worse and darkest periods in my life. I certainly felt alone. I was living in a town that was about 200 Km from my family. I had moved there, foolishly, to be nearer the fleecing girlfriend. She was history, so there I was, alone, and I really didn't know anyone else in town. Town? It barely had 1,800 people in it. Talk about feeling like a fish out of water! I had moved from the Kansas City area, where the metropolitan population is somewhere around 2,000,000 people. Yes, million. Two of them.


If you don't know much about small towns in the rural parts of the midwestern U.S., let me tell you a few things. First, the sidewalk literally rolls up at six or seven in the evening. Most of the local businesses cease operation. The only things open in town after that time were a convenience store, a bar, McDonalds, and Pizza Hut. Second, you're either from there, or you're not. And if you're not, good luck fitting in and making friends. Once an "outsider," you're always an outsider. Oh, people are kind and "friendly," but that isn't the same as friendship. As hard and as much as I tried, I never really made friends there. I was that prototypical outsider. In retrospect, the longer that situation went on, the harder I tried. In the end, I probably tried too hard and too much, without any gain.


That first phone call lasted for HOURS. Over the ensuing years, the phone calls became regular, sometimes daily, as we talked about every topic under the sun. Sometimes, the phone calls were just minutes long. But, most often, they were hours long. Such was the bonus of having unlimited long distance calling on my landline, long before it was popular or prevalent.


I knew she was older than me, but I never knew how much older. After all, it's considered poor manners to ask a woman her age. I only knew that we both had birthdays in August. We were just really good friends, on a strictly platonic level. We didn't always agree on things, but simply agreed to disagree on those topics. But we agreed on many, many things. She told fabulous tales of her family, her kids, her many travels and exploits, the work she had done and was doing. At first, I thought they sounded rather embellished, as tales sometimes have a way of sounding over the years. But, as time went on, I began to realize that the tales were most likely true, since every time they were told, the details never changed. I never tired of the tales, nor the conversation.


As the years went by, we had still never met, face to face. We talked frequently, mostly on the phone. As email began to become more popular, it was also worked into our communication regimen. She was my best friend, a kindly voice and person always willing to lend an ear and friendly advice. All of this, despite having never met. Girlfriends came and went, jobs came and went, but the one constant was my long distance friendship with her to ground it all. She moved from Stamps, AR to Hot Springs, AR. In Hot Springs, she bought two adjoining condos on Lake Hamilton, and had them redesigned into one large million dollar condo. It was literally feet from the lake. Go out on her dock just 30 feet from her patio door, and you literally were standing on Lake Hamilton.


My friend was a pioneer, of sorts. It was a role that she loved. She fell in love with -- and moved to -- Alaska before it was even a state of the U.S. Her tales included how she and her then husband built roads for the logging industry in Alaska. There were tales of her as a bush pilot, flying with high profile visitors into the Alaskan wilderness. There were still other tales of hunting moose, caribou, bear and deer to provide meat for the camp meals. There were many tales of fishing. One of her favorite sayings and advice was to fill up your life with the three "F's" ... friends, family and fishing.


After moving back to Arkansas after her divorce from her husband in Alaska, she took care of her aging mother. She also threw herself into the young, fledgling computer industry. She learned programming, especially as it applied to digital publishing. She became a beta tester of many of the software packages many computer users the world over still use today. She was even a consultant for the U.S. Department of Defense on some of their computer systems. She talked fondly and often about her friend, Rod Willmot, an author and digital publishing pioneer himself.

 

 


Finally, in or around 2004, while I was with the last girlfriend before I met my current wife, Laura, we made a brief trip down to Hot Springs to finally meet my long time friend. The image above is from that trip. After nine years of talking on the phone, we finally got the opportunity to meet, face to face.


After my wife and I married in 2006, we took a delayed honeymoon down to Hot Springs, where we were my friend's guest in her million dollar condo. We had a great time, as newlyweds typically do, but we also spent some high quality time with my friend, just the three of us.

 

 


That was the last time I ever saw my dear friend. Oh, we stayed in touch for quite some time afterwards. In fact, we stayed in touch until shortly after she moved in with her son, in Port Angeles, Washington. Afterwards, contact became increasingly sporadic, until finally, I didn't hear anything.


The two pictures here are the only two pictures I have of my dear friend. But the memories of the many, many conversations we had are endless.


Sometime, during the last week of November, I entered her name into Google. That is when I discovered why things had gone silent. She had passed away after a brief battle with cancer on August 31, 2016. Her name was Bobbye Lynn Hildre, although I only knew her as, and referred to her as, Lynn. In fact, I don't think I ever knew she had "another" name. The last email I ever received from Lynn was her reaction to my son, Ryan, being born. I emailed her on September 1, 2013, and heard back from her on September 19, 2013. That was the last time I ever heard from her.


Lynn was a huge supporter of PCLinuxOS, and of course, The PCLinuxOS Magazine led by her friend. She never joined the forum, instead using me as her personal and private support person. She did install and use PCLinuxOS. She looked forward to each and every release of The PCLinuxOS Magazine.


It wasn't until I read her obituary that I realized how old she was (she was 82 when she passed away, 26 years my senior). Not that it mattered. We were friends. The best of friends. We literally had a friendship that transcended time, distance, and most of the frailties that curse mankind. She was that ONE special friend that entered my life when I needed a friend the most. She was that ONE special friend that just wouldn't take no for an answer. She was that ONE special friend that kept knocking and kept knocking on my door, until I finally answered.


I'm sure glad I did open that door. The impact she has had on my life is untold, and that story isn't anywhere near finished. She's one of those special people who have a lasting impact, long after they are gone.


I miss you, Lynn. I miss our long, long conversations about everything and anything under the sun. I miss your fascinating stories, whether it's the first time or 20th time hearing them. I think often of my dear and departed friend. I'm just sad that it took me over two years to finally discover her fate.


During this holiday season, the most sincere gift I can wish for you is to hope you find a Lynn in your life. If you already have a Lynn in your life, you're that much closer to happiness. Embrace that friendship. If you don't have a Lynn in your life, be sure to answer the door when they come knocking. You won't regret it.


Please forgive the extra long length of this month's column, but it took some doing to tell this story. I've shared with my PCLinuxOS family, here, things that few others know about me, and about the light that got me through one of the darkest periods of my life.


Until next month, I bid you peace, happiness, serenity and prosperity.



 
 








  
Paul's 2018 Holiday Gift Guide
 
 



by Paul Arnote (parnote)


Ah, already? Yep. It's that time of year again. It's time to start thinking about holiday gifts for those on your holiday gift list ... or maybe even something special for yourself.


No matter what holiday you celebrate (or even if you don't celebrate the holidays), this time of year offers up some amazing buys that are hard to pass up.


The gift ideas here represent what I think might make great gift ideas for the holidays. Similar gift idea lists from Meemaw and YouCanToo reflect their ideas for holiday gifts. We each have varied interests, and those holiday gift lists will reflect those varied interests. The items we choose to list reflect items that either we think would make great gifts, or items that we wouldn't mind receiving ourselves as gifts. As such, the lists are highly personalized and flavored with our varied interests, so you may (or may not) agree with all of our selections. All prices are in U.S. currency, and may or may not be available to you in your location, thanks to import/export restrictions, local laws, duties, VATs and other such governmental nonsense.


So, with that out of the way, let's get started with my holiday gift guide. By the way, this is my 10th annual holiday gift guide for The PCLinuxOS Magazine.

 


SOG Countertop Knife Sharpener

$19.99, from Sportsman's Guide

 

 


Whether it's used in the kitchen or in the field, one thing knife users know is that a dull knife is a more dangerous knife. When a knife dulls, we try to compensate for the lack of a sharp edge by applying more and more pressure to the knife, hoping it will eventually perform its designed task to cut something. But as we apply more and more pressure to a knife, it's easy to pass right on by that tipping point where we lose control of the knife, making the chance of getting cut by the now-out-of-control knife exponentially higher. A sharp knife glides easily through material (within reason), allowing you to maintain absolute control over the knife, thus greatly lowering your chance for personal injury from an out-of-control knife.


Rely on this newest generation of SOG® Sharpeners to turn dull knives into razor-sharp cutlery tools in a flash. Simply set the Sharpener on any flat, non-porous surface and activate the suction. Just a few passes, and you've got a clean knife edge, just like new! For single or double-edged blades. 2 1/2" x 2 3/4"h. Weighs 3 ozs.

 

Lansky Quadsharp Portable Sharpener

$16.99, from Sportsman's Guide

 

 


The Lansky® Quadsharp Portable Sharpener ensures the correct sharpening angle, even in unfavorable outdoor situations. It gives you the option of using four different angles (17°, 20°, 25°, and 30°) that allow the exact level of sharpness for your unique cutting requirements. In just three to four strokes, turn a dull, dangerous, blade into primo operating perfection. It uses Lansky's legendary Controlled Angle System, has a ceramic benchstone (800 grit) for polishing, and features convenient, compact storage.

 

Amazfit Bip Smartwatch by Huami with All-Day Heart Rate and Activity Tracking, Sleep Monitoring, GPS, Ultra-Long Battery Life, Bluetooth, US Service and Warranty (A1608 Black)

$79.88, from Amazon.com

 

 


Smart watches have become all the rage, but they are expensive, regardless of the platform (Android or iOS). The Samsung Gear S2 watch sells for $140. The Fitbit Blaze Smart Fitness watch sells for $150. The Ticwatch S Smartwatch-Knight sells for $200. And forget about the Apple Watch. It's selling price starts in the hundreds of dollars, and goes up from there. By the way, this item comes from my own Amazon Wish List.


Finally, Amazon partnered with Huami and created the Amazfit Bip Smartwatch, an affordable smart watch for everyone else, selling for under $80. Amazon and Huami didn't skimp on the features, either. Not only does it do what you expect a watch to do (keep/tell time), but it also displays SMS text messages and app notifications from your mobile device (no, you cannot respond to SMS text messages at this price point ... yet).


Additionally, it receives one-way notifications for emails, incoming phone calls (prompting you to take action on your smartphone), as well as alerts for Facebook, Twitter, WhatsApp, LinkedIn, Snap, Slack, weather forecasts, and other mobile apps. The optical heart rate monitoring and built-in GPS allow you to accurately track in real-time your steps taken, distance traveled, calories burned, and quality of sleep. Special sport modes (running, treadmill, cycling and walking) give you even more detailed insights into your most frequent activities.


The Amazfit Bip is lightweight, weighing in at a very light 1.1 ounces (32 grams). It's also IP68 dust- and waterproof. A 2.5 hour charge lasts 30 days.

 

AIFUDA 3 Pcs Car Dashboard Pads Non-Slip 11" x 7", Anti-Slip Ripple Sticky Dash Grip Mat for Coin Phone Key Sunglasses - Black

$15.99, from Amazon.com

 

 


Today's cars and trucks have dashboards made of hard, slick vinyl and plastic. Don't try to store anything on the dash, because whatever you put there will slide all around when you accelerate, decelerate or corner. Your item(s) won't stay on the dash for long, anyways.


These 11 inch by 7 inch (28cm x 18cm) "sticky" mats are 3mm thick mats of soft latex rubber (please, pass on these if you have a latex allergy). This item is for a package of three sticky mats, so you'll have enough to place one in all of your vehicles. The underside grips your dash without the use of magnets or adhesive. Place your items – glasses, keys, sunglasses, phones, small tablets, GPS units, radar detectors, etc. – on the mat, and the days of your items becoming airborne or skating across your dash are over. The top side of the sticky mat will grip most any non-porous item you place upon it. Should it become dirty, just wash it off with soap and water, dry, and use over and over.

 

Original Lensball Pro 80mm, K9 Crystal Ball with Microfiber Pouch, Photography Accessory

$38.99, from Amazon.com

 

 


Whether you do film or digital photography, whether you use a dSLR or a smartphone camera, Lensball Pro can help take your photography to new heights of creativity. It is a gorgeous photography sphere made out of high-grade optical crystal that allows anyone to dive into endless creative photography possibilities. You can capture a 180-degree view of your surroundings, right in the palm of your hand and it is so simple that anyone can use it. Furthermore, Lensball is perfectly suited for any kind of camera, smartphone or professional high-end camera.


Their mission is to give you the best product that makes it extremely easy to discover totally new perspectives and ways to express your creativity.


Lensball makes for a truly great gift. It's stunning yet incredibly simple to use, and suited for every photographer, amateur or professional. Plus it arrives in a beautifully designed package including a carrying pouch.


Package includes:

1x 80mm Lensball

1x Microfibre carrying bag (can also be used to clean from fingerprints)

1x Lensball sticker

1x Manual

4x showcase cards

 

Weston Original Jerky Gun

$39.99, from Sportsman's Guide

 

 


Make delicious, homemade jerky and sausage! And who doesn't like good beef jerky and meat sticks (except for a vegetarian)?! For easy, reliable use, count on The Original Jerky Gun from Weston®. With an easy-squeeze trigger, everyone in the family can get in on the jerky-making process. And with multiple attachments for snack sticks, strips and sausage, there's a recipe for everyone to enjoy!


Features:50


 	Easy-squeeze trigger

 	Holds up to 1.5 lbs. of meat



Includes:

 	Stainless steel double snack stick attachment makes 1 1/2" diam. sticks

 	Stainless steel double jerky strip attachment makes 1/8" x 3/4" strips

 	Plastic sausage funnel

 	Stomper for easy loading

 	Cleaning brush set

 	12 oz. of Weston Jerky Seasoning


 


PCLinuxOS 16 oz Insulated Stainless Steel Travel Mug

$19.99, from the PCLinuxOS Store on Cafe Press

 

 


This insulated travel mug features durable double-wall stainless steel construction, designed to keep a 16 oz. beverage hot or cold for hours. It features a spill-resistant lid that has a convenient carry handle on the lid. Measuring 7.25"x3.5", this coffee tumbler fits most car cup holders for an easy commute. Hand wash only. A portion of all sales goes to help support PCLinuxOS.

 

Vinyl Oval Sticker (10 Pack)

$24.95, from the PCLinuxOS store on Cafe Press

 

 


Show your support for PCLinuxOS by placing these oval vinyl stickers on your laptop's lid, on the side of your desktop, or even on back bumper or window of your car. Printed on durable 4 mil vinyl with premium inks to resist the sun and elements, your message will last and last. The 3" x 5" stickers are available with a white or clear background. A portion of all sales goes to help support PCLinuxOS.

 

The GorillaBox - The ChimpBox's Bigger Brother

$435.00, from Chimpbox.us

 

 


 	 Brand AMD

 	 Model A68N-5545 
 
 	 CPU AMD A8-5545 (Quad core 1.7G, turbo 2.7G) Processor 
 
 	 Memory 16GB DDR3 PC12800 Installed - 16 GB Max 
 
 	  Drive 1TB SSHD Drive 
 
 	 CD/DVD Readable Format(s): CD-R, CD-ROM, CD-RW, DVD+R, DVD+R Dual Layer 
 
 	 Writable Format(s):     CD-R, CD-RW, DVD+R, DVD+R Dual Layer, DVD+RW 
 
 	 Card Reader 4-slot reader reads CF, SD, MMC, SM, and Sony MS media. with 2- USB 2.0 ports 
 
 	 Storage Devices SATA 2 x SATA 6.0Gb/s 
 
 	 Onboard Video Chipset 
 
 	 AMD Radeon HD8400 Graphics, On Board Graphic Max. Memory Share Up to 2GB 
 
 	 Onboard Audio Audio Chipset Realtek ALC662 
 
 	 Audio Channels 6 Channels 
 
 	 LAN Speed 10/100/1000Mbps 
 
 	 Comes with 64 bit PCLinuxOS, KDE desktop pre-installed 
 
 	 Built and tested to order, when ordered 
 
 	 Black case only 
 

 


PCLinuxOS GoFundMe Donation


 

 



Make a donation, either in your name or in the name of your favorite PCLinuxOS user, to help keep PCLinuxOS going. While PCLinuxOS is free (as in beer), the cost of producing it is not. There are costs associated with having the necessary equipment, internet service, servers, etc. PCLinuxOS does not have any large corporate sponsors, and it certainly isn't backed by the unlimited funds of a billionaire. The development of PCLinuxOS is driven by its community, and carried out by dedicated volunteers. Any amount is appreciated.



************************


We at The PCLinuxOS Magazine would like to wish you and yours a very happy holiday season.
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 Meemaw's 2018 Holiday Gift Guide
 
 

 
 
by Meemaw


Wow, it's that time of year again! This year has flown by again, and it's time to shop for that special gift for each friend or family member you are buying for, and not ruining your budget in the process. I have found a few gifts that might just be right or different enough for that one hard-to-buy-for friend or relative. All prices are in US dollars.


As you know, one of my favorite places for something different is Bits and Pieces. Since I have bought from them previously, I received a catalog in the mail this year. Let's see what they have that's new:

 

Harmony Bell Chimes   $14.99

 

 


I don't know about you, but I love wind chimes! Most of them have the tube-shaped chime pieces, and when I saw this one, I thought it looked really wonderful. Many others are also constructed with cord, but this one is all metal, which should make it more durable if hung outside. Instead of blowing back & forth, this one spins, which rings the bells. I'm thinking of asking for this for Christmas so I can listen to it. It measures 8.25" in diameter and 7.5" long with a 12" chain to hang it.

 

Puppy Mug & Spoon   $12.99

 

 


(Oh, no.... Another coffee mug!) Sometimes I think that too, because I have loads of coffee mugs. This one has an extra added attraction - a spoon right there with the mug, so you don't have to go looking for a spoon to add your sugar or cream. If you don't want puppies, they offer mugs with kittens or owls. The cups hold 10 oz., and needs to be hand-washed.

 

Mushroom Garden   $24.99

 

 


You can buy mushrooms in most any grocery store in the US, but if you could grow your own, they would be really fresh! This is a kit for growing mushrooms yourself. You should have your first crop in about two weeks, and can grow multiple crops.

 

Greenhouse Model Kit   $39.99

 

 


We all know that teenager who loves to build models, and while they are usually model cars, this kit will let him/her build something besides a vehicle. When finished, the incredibly detailed model is 7.75" x 7" x 7".


Another one of my favorite sites is L L Bean. They have loads of clothes and sports equipment, but they also have an assortment of gifts, pet supplies and outdoor games. Close to the holidays, many of their gifts are Christmas-themed. One of my brothers has sent me an outside Christmas wreath off & on for many years. You might think they are too expensive, but like I have said before, their flannel shirts have lasted my husband ten years or so, and in comparison, the less expensive shirts sometimes last only one or two years... so, five times as long for less than five times the price is a bargain to me.

 

Needlepoint Stocking   $29.95

 
>
Some people take yard games with them when they go camping. This portable set looks fun! LLBean says it's easy to set up, and includes ladder ball, bag toss and quad toss games. 

Assembled size is 39" x 39" x 36".

 

Collapsible Mini Camp Light   $19.95

 

 


If you go camping, or even just out in the back yard, you might need some light. These look really handy. They are small when stored (1.6" tall and 2.5" wide) and 3.25" tall when expanded. They aren't huge, but good for a bit of light in a couple of places. They have 4 modes: High, Low, Multicolor and Glo. The outside of the globe is glow-in-the-dark silicone, which continues to glow after the light is turned off.   


I have also been ordering from Amazon - you can get nearly anything there! Occasionally, I go and just look at some of the gifts they have. I've found several really different items.

 

Kabake Non Skid Ballet/Yoga Toe Socks   $5.99 or package of 3 for $9.99

 

 


Those of you who do pilates or Yoga might like these. Many times those types of workouts are done barefoot. These socks will let you work out at home or at a studio and keep your feet clean (and warm, if you're like me.) 

 

Velee Reusable Smart Erasable Notebook    $15.99 or $22.99 with a leather cover.

 

 


This is one of several notebooks I have seen recently. Using the special pen to write on the pages, you can then erase the page with heat or a damp rag. Also, according to Amazon, This smart notebook is compatible with the CamScanner app. That means before your notes go off the page, you can put them to destinations like Dropbox, Evernote, OneNote, OneDrive, Google Drive, Box, iCloud or your email address, both PDF and JPG form are available." It has 20 pages of wide ruled paper, 20 pages of dot grid paper and 20 pages blank paper. You can do almost anything with that variety.

 

Boil-over Safeguard   $15.90

 

 


You're cooking spaghetti or potatoes, and you get called away from the stove for just a minute. When you come back, your pot has boiled over. Darn! (It's happened to me before.) This item is supposed to prevent that. You simply put it on top of the pan and let it boil normally. It is silicone and fits pans 6" to 10" in diameter.

 

Lavatools PT12 Javelin Digital Instant Read Meat Thermometer   $24.99 

 

 


Compliments of Rudge, this was suggested as a great present as well, because he has two of them. It has an ultra-fast response time, it's very accurate, has a magnet on it so it's never lost, and has a lifetime guarantee. Rudge says it is the best, and most affordable, instant-read thermometers he's ever had!


Oh, and as a finale, for your incurable Harry Potter fanatic, Lego has a whole series of Lego creations from the Harry Potter universe, including Hogwarts Castle for those ages 9 - 14. ($99.97 at Amazon)

 

 


This one has ten of the characters to go along with the buildable castle, and also includes a boat, Fawkes the phoenix, Hedwig the owl, Scabbers the rat and a buildable Basilisk.


I hope you can find something for that hard-to-buy-for person on your list, and most of all, I wish you all a happy, healthy and prosperous holiday!


 


When I was a child, my mother made stockings for everyone, and I still have mine. However, families increase in size, and some people aren't as creative. LLBean has these nifty needlepoint stockings in nine different designs so you can get a different one for everyone on your list. I'm sure they will last for years and years. The stockings are 18" long and can have a name embroidered on them for an extra charge.

 

3-In-One Portable Game Center   $49.95

 

 


Some people take yard games with them when they go camping. This portable set looks fun! LLBean says it's easy to set up, and includes ladder ball, bag toss and quad toss games.

Assembled size is 39" x 39" x 36".

 

Collapsible Mini Camp Light   $19.95

 

 


If you go camping, or even just out in the back yard, you might need some light. These look really handy. They are small when stored (1.6" tall and 2.5" wide) and 3.25" tall when expanded. They aren't huge, but good for a bit of light in a couple of places. They have 4 modes: High, Low, Multicolor and Glo. The outside of the globe is glow-in-the-dark silicone, which continues to glow after the light is turned off.   


I have also been ordering from Amazon - you can get nearly anything there! Occasionally, I go and just look at some of the gifts they have. I've found several really different items.

 

Kabake Non Skid Ballet/Yoga Toe Socks   $5.99 or package of 3 for $9.99

 

 


Those of you who do pilates or Yoga might like these. Many times those types of workouts are done barefoot. These socks will let you work out at home or at a studio and keep your feet clean (and warm, if you're like me.) 

 

Velee Reusable Smart Erasable Notebook    $15.99 or $22.99 with a leather cover.

 

 


This is one of several notebooks I have seen recently. Using the special pen to write on the pages, you can then erase the page with heat or a damp rag. Also, according to Amazon, This smart notebook is compatible with the CamScanner app. That means before your notes go off the page, you can put them to destinations like Dropbox, Evernote, OneNote, OneDrive, Google Drive, Box, iCloud or your email address, both PDF and JPG form are available." It has 20 pages of wide ruled paper, 20 pages of dot grid paper and 20 pages blank paper. You can do almost anything with that variety.

 

Boil-over Safeguard   $15.90

 

 


You're cooking spaghetti or potatoes, and you get called away from the stove for just a minute. When you come back, your pot has boiled over. Darn! (It's happened to me before.) This item is supposed to prevent that. You simply put it on top of the pan and let it boil normally. It is silicone and fits pans 6" to 10" in diameter.

 

Lavatools PT12 Javelin Digital Instant Read Meat Thermometer   $24.99 

 

 


Compliments of Rudge, this was suggested as a great present as well, because he has two of them. It has an ultra-fast response time, it's very accurate, has a magnet on it so it's never lost, and has a lifetime guarantee. Rudge says it is the best, and most affordable, instant-read thermometers he's ever had!


Oh, and as a finale, for your incurable Harry Potter fanatic, Lego has a whole series of Lego creations from the Harry Potter universe, including Hogwarts Castle for those ages 9 - 14. ($99.97 at Amazon)

 

 


This one has ten of the characters to go along with the buildable castle, and also includes a boat, Fawkes the phoenix, Hedwig the owl, Scabbers the rat and a buildable Basilisk.


I hope you can find something for that hard-to-buy-for person on your list, and most of all, I wish you all a happy, healthy and prosperous holiday!
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YouCanToo's 2018 Holiday Gift Guide
 
 



by YouCanToo


Once again, we're making a list and checking it twice. Here is my list of gift giving ideas for 2018.


Jamal Alarm Clock Water Power Digital Weather Station Time Humidity Large LCD Display and Temperature Measurement Environmental Technology 

 

 


These clocks need no power, no batteries, no sunlight. As long as it's filled with ordinary tap water, the water clock will run. One fill provides continuous power for around 2 weeks. This water powered clock also gives you up-to-date weather forecasts and displays the temperature and humidity. (Celsius or Fahrenheit)

Amazon   --  $12.99    

 


Carry Coffee on the go, at the exact temperature you like, all day long!

 

 


The Cauldryn is the best friend of the person on the go.  A heated electronic mug that uses battery power to keep your coffee or tea at your selected temperature all day long, it makes each sip perfect.  Brew coffee and tea, cook, or even boil water right in the bottle.

Cauldryn Coffee  --  $129.00

 


RoadPro 12-Volt Portable Stove

 

 


The RoadProRPSC-197 is the ultimate lunch box for your mobile, on the go, lifestyle. Perfect for camping, tailgating, or wherever your life takes you. Not just for warming up leftovers, the portable stove is capable of cooking food up to 300 degrees.

Amazon  --  $29.00

 


Southern Bourbon Stout Beer Brewing Kit

 

 


Bourbon-soaked oak chips give the stout beer you'll brew rich vanilla notes and a smooth finish. Isn't it time you made the leap from beer drinker to beer brewer? Get off the sidelines and turn your kitchen into a craft brewery where you're the brew master and your friends and family are the master taste testers! Makes one gallon, or ten 12 oz bottles. 

Draft Beer Kit  --  $45.00  --  refill kits available.

 


Star Wars R2-D2 USB3.0 Charging Hub

 

 


For all you fans of Star Wars, there are lots of astromechs out there, but no design more popular than the venerable R2 unit. Sure, BBs are great, but R2 units have a special place in our hearts. And although not everyone can speak in bleeps and bloops, you never have much trouble getting the gist of what they're trying to say.

Think Geek  --  $59.99

 


Funny Guy Mug, Ceramic Coffee Mug, White, 11 ounce.

 

 


There is more to this mug than just a funny message. The image is professionally printed to ensure this will last in the microwave and dishwasher.  We also printed the image on both sides to make sure left-handers did not feel left out.

Amazon  --  $11.99

 


MRQ 14.1 inch Digital Photo Frame with Remote Control

 

 


The MRQ digital photo frame is equipped with a 14.1 inch 1280*800 high resolution LED screen, MR.Q digital frame brings superb picture quality on its unbelievable whopping screen. It also supports 1920 x 1080 Full HD resolution video playing with a 16:10 aspect ratio. 

Amazon  --  $69.99

 


Amazon Smart Plug

 

 


Turn any outlet in your home into a smart outlet with smart plug.  Schedule lights, fans, and appliances to turn on and off automatically, or control them remotely when you're away. Compact design keeps your second outlet free. Simple to set up and use-plug in, open the Alexa app, and start using your voice.
     
Amazon   --  $24.99

 


Echo Dot (2nd Generation) - Smart speaker with Alexa

 

 


Echo Dot is a voice-controlled speaker that uses Alexa to play music, control smart home devices, make calls, answer questions, set timers and alarms, and more. Play music from Amazon Music, Spotify, Pandora, iHeartRadio, TuneIn, and SiriusXM . Call or message family and friends hands-free, or drop in from the Alexa App to your Echo device. Controls lights, locks, thermostats, and more with compatible connected devices 
    
Amazon  --  $39.99

 


Magnetic Balance Lamp

 

 


It's a Balancing Act

No switch? No problem. this ingenious lamp turns on and off with a flick of the wrist... and the nudge of a little round magnet. Simply lift the lower sphere to switch the light on. It's attracted to the upper sphere and will stay put in midair, giving off the light you so crave.

Uncommongoods  --  $70.00

 


Galileo Globe Thermometer







Colorful glass bulbs in different weights rise or sink when the temperature of the room (and the liquid) changes, creating subtle lava lamp-style movement. They also feature tags for both Fahrenheit and Celsius. While most versions of this thermometer are cylindrical, this design is circular and sits on a handsome wood base, making it a distinct desktop conversation starter.

Uncommongoods  --  $25.00




 
 

 
 









  
phorneker's 2018 Holiday Gift Guide
 
 



by phorneker



Disclosure:  In addition to working with this magazine and my website, I am an operations associate at Kohl's Department Stores, and per their social media policy, I am required to disclose that I am affiliated with Kohl's and opinions shared here are those of my own, and not that of Kohl's Department Stores.


The holiday season once again has just arrived, but now we have fewer brick and mortar stores to shop from this year. Direct Buy of Merrillville, Indiana purchased the rights to the intellectual properties of Bonton Stores and has reopened Carson Pirie Scott as an online retailer. This comes less than a month after Bonton Stores had shut down its brick and mortar operations.


Unfortunately, the Carson's charge cannot be used with the online retailer. (Comenity Bank has closed down all Carson's charge accounts.)


Since then, a new (brick and mortar) Carson's is opening in Evergreen Park, IL and plans for more new stores in the Midwest are in the works. (The next stores will be in Lombard, IL and Orland Park, IL, Brookfield, WI and Grand Junction, CO.) 


Hearing of this brings back memories of actually going out to the malls at Christmas time to purchase gifts. (This is one of the things that gave me the inspiration to write my articles on the Seeburg 1000.)


Having said this, I recommend shopping brick and mortar this year while it is still possible to do so ... and now for the gift ideas.

 

Gift Idea #1: Epson All-In-One Printers

 

 


If you need to give a printer this season (that works with PCLinuxOS), I recommend any of the Eco-Tank line of printers from Epson. Not only will the printers work with PCLinuxOS (the ESC-P/R open source driver is available for download), but either you or whoever gets the gift will save more than $1,000 in ink costs over a two year period thanks to the ink coming in tanks rather than cartridges.


In addition, he/she will get a printer that is best suited for photographs, color brochures, artwork, resumes, and other documents that demand high quality output, and will get a printer that will last.


I had my Epson Stylus NX-415 for the past ten years, and it is still working today.


These printers can be purchased at OfficeMax (and Office Depot), Staples, Wal-Mart, Best Buy, and Target, as well as online through Amazon.

 

Gift Idea #2: Photographs on Metal

 

 


Imagine some of your best photographs printed on metal and prominently displayed. This would be a gift that lasts for years. The cost for the images depends on the size of the image and where you get it done.


Costco offers metal prints infused on aluminum panel with rounded edges for:

 	 $33.99 for 11x14 (standard photograph size) or 12x12 (the size of a vinyl album jacket)

 	 $39.99 for 16x20

 	 $59.99 for 16x24

 	 $93.99 for 20x30

 	 $119.99 for 24x36



Collages of up to 30 photographs are also available in the above sizes for the same price.

Shutterfly offers a similar service where photographs are printed and treated to be fade and scratch resistant.


Metal prints are regularly priced at:

 	 $59.99 for 8x10

 	 $84.99 for 10x14 or 12x12

 	 $94.99 for 16x16

 	 $99.99 for 16x20

 	 $199.99 for 20x30

 	 $299.98 for 24x36



The good news here is that there are specials on these that are regularly advertised. Select the Upload Your Design option to order prints from Shutterfly.

Adorama Photo offers metal prints in the following shapes:



 

All Adorama products are finished in your choice of glossy white, glossy silver, white satin or silver satin.


Art Beat Studios offers metal prints with your choice of each of the following options:

 	 White or silver surface

 	 Glossy or matte finish

 	 Natural Wood, Black Wood, Silver Aluminum or Black Aluminum backing for the metal print

 	 Wire hanger or cleat hanger. The cleat hanger has a built in level indicator.

 	 Recessed or Flush mount. Recessed mount projects the print out by one inch.



Regular pricing for the prints are as follows:
 
 



Your local Walgreens offers the metal print service with rounded corners for:



 

Gift Idea #3: Instant Pot

 

 

5
This programmable pressure cooker from Ottawa was very much in demand last year, and is still in demand this year. Currently, the Instant Pot line of products have capacities of three, six and eight quarts.


The Duo and Duo Plus series models are available in stock at most brick and mortar retailers. These appliances were designed to replace the typical slow cooker, rice steamer, hotplate, and fondue pot. The concept here is that you simply place the prepared food into the appliance, select what you are cooking from a menu (or simply pressing a button depending on model), and allowing the appliance to do the rest (provided, of course, that the appliance is properly setup).

 

Gift Idea #4: Voice Assistant Devices


 


This is the future of Internet searching. Devices such as this Amazon Echo (3rd generation), and Google Home have increased in popularity over the past year. No, this will not replace the PCLinuxOS machine (at least not any time in the near future).


In fact, I have been researching how to get my website Alexa friendly so devices like these will complement rather than replace the PCLinuxOS machine.


These devices could be purchased for as low as $40.00 for the basic model (Amazon Echo), and not just at Amazon, either, but at major brick and mortar retailers.


No voice assistant device is perfect, as we have seen numerous problems with these devices, particularly of the privacy kind, as well as providing information that is relevant to the search. The latter has more to do with the programming and structure of websites than with the Alexa technology itself.

 

Gift Idea #5: And Now For Something Completely Different

 

 


I am talking about the official Monty Python online store. You can shop here for most anything related to Monty Python. Included here are references to:


 	 Spam

 	 Dead Parrot Sketch

 	 Lumberjack Song

 	 The Killer Rabbit

 	 'Tis But a Scratch

 	 Brave Sir Robin

 	 Ministry of Silly Walks

 	 I'm Not Dead Yet

 	  my absolute favorite, "The Holy Hand Grenade"




Wishing you a happy holiday season, no matter how we shop.


 
 

 
 


 
 


 
 


 
 


 
 


 
 









  
ms_meme's Nook: Don't Bring Windows
 
 





Ogg
                                                            
MP3












  
PCLinuxOS Recipe Corner: Double Barbecue Bacon Chicken
 
 





Double Barbecue Bacon Chicken




Ingredients


1 1/4 lb Yukon gold potatoes, cut in 3/4-inch  

2 teaspoons oil  

1 tablespoon Italian seasoning  

3/4 teaspoon salt  

1/4 teaspoon pepper  

4 boneless skinless chicken breasts (6 oz each)  

1 1/2 teaspoons barbecue seasoning  

4 slices cooked bacon, halved crosswise  

1 cup shredded Cheddar cheese (4 oz)  

1/4 cup barbecue sauce  

2 green onions, sliced  



Directions


1. Heat gas or charcoal grill. Cut 4 (18x12-inch) sheets of heavy-duty foil. Spray with cooking spray.
 
 

2. Add cut potatoes to medium bowl. Drizzle with oil; sprinkle with Italian seasoning, salt and pepper. Stir until evenly coated.
 
 

3. Season chicken with barbecue seasoning, and place on center of each sheet of foil. Dividing evenly, spoon potato mixture around each chicken breast. Lay bacon slices over chicken.
 
 

4. Bring up 2 sides of foil so edges meet. Seal edges, making tight 1/2-inch fold; fold again, allowing space for heat circulation and expansion. Fold other sides to seal.
 
 

5. Place packs on grill over medium heat. Cover grill; cook 10 minutes. Rotate packs 1/2 turn; cook 9 to 10 minutes longer or until juice of chicken is clear when center of thickest part is cut (at least 165F). Remove packs from grill; cut large X across top of each pack. Carefully fold back foil; sprinkle potatoes with cheese. Top each chicken breast with 1 tablespoon barbecue sauce, and garnish with green onions.
 
 

Serves 4


Options:


Small Yukon potatoes can be halved and substituted for Yukon potato chunks in this recipe.
 
 

To make in oven, place packs on cookie sheet. Bake at 375F - 32 to 35 minutes or until juice of chicken is clear when center of thickest part is cut (at least 165F).




 
 

 
 


 
 









  
YouTube: Now Offering Free Movies With Ads
 
 



by Paul Arnote (parnote)


Quietly, sometime in October, 2018, YouTube began offering 100 "high profile" movies to be viewed for free ... but with a catch. These movies are free, but with ads. Kind of like commercial TV in the U.S.


YouTube calls it their "Free With Ads" option. Included are critically acclaimed movies, such as the five Rocky movies, The Terminator, and Legally Blonde. Other films included are Igor, All Dogs Go To Heaven, and With Great Power: The Stan Lee Story.

 

 


"We saw this opportunity based on user demand, beyond just offering paid movies. Can we do ad-supported movies, free to the user?" Dhawan says in an AdAge article. "It also presents a nice opportunity for advertisers."


Now, viewing full length feature films on YouTube isn't necessarily a new thing. Starting in 2015, YouTube started offering subscription-based content with YouTube Red. Previously, YouTube users could purchase full-length feature films. This represents the first time that YouTube has given users a chance to watch these quality movies by opting for ad interruptions, versus paying to watch a movie.


Here's a full list of free films now available, with ad breaks, on YouTube:


 	 Rocky

 	 Rocky II 
 
 	 Rocky III 
 
 	 Rocky IV 
 
 	 Rocky V 
 
 	 Legally Blonde 
 
 	 Legally Blonde 2 
 
 	 Igor 
 
 	 Agent Cody Banks 
 
 	 Agent Cody Banks 2 
 
 	 Sleepover 
 
 	 Zookeeper 
 
 	 What's the Worst That Could Happen 
 
 	 Kano 
 
 	 Terminator 
 
 	 The Man in the Iron Mask 
 
 	 All Dogs Go To Heaven 
 
 	 The Magic of Belle Isle 
 
 	 The Pink Panther 2 
 
 	 Out of Time 
 
 	 Uptown Girls 
 
 	 A Guy Thing 
 
 	 Flawless 
 
 	 Hackers 
 
 	 Experimenter 
 
 	 The Wrath of Vajra 
 
 	 Bio-Dome 
 
 	 Blackthorn 
 
 	 Return to Me  
 
	 With Great Power: The Stan Lee Story 
 
 	 Throw Momma From The Train 
 
 	 Saved 
 
 	 Dino King 
 
 	 Dirty Rotten Scoundrels 
 
 	 The Sorcerer and the White Snake 
 
 	 Monsters 
 
 	 Kung Fu Killer 
 
 	 Good Boy! 
 
 	 Trail of the Pink Panther 
 
 	 Son of the Pink Panther 
 
 	 Curse of the Pink Panther 
 
 	 Very Good Girls 
 
 	 The Hero of Color City 
 
 	 Slightly Single in LA 
 
 	 Tai Chi Hero 
 
 	 The Timber 
 
 	 Jiro Dreams of Sushi 
 
 	 A Company Man 
 
 	 Special ID 
 
 	 The Assassins 
 
 	 Drug War 
 
 	 Four Weddings and a Funeral 
 
 	 McCanick 
 
 	 Mystery Road 
 
 	 Ip Man: The Final Fight 
 
 	 New World 
 
 	 Main Street 
 
 	 Europa Report 
 
 	 The Great Buck Howard 
 
 	 The Pirates 
 
 	 Police Story: Lockdown 
 
 	 The World's Fastest Indian 
 
 	 Memories of the Sword 
 
 	 The Suspect 
 
 	 Wu Dang 
 
 	 White Haired Witch 
 
 	 Rejoice & Shout 
 
 	 The Woods 
 
 	 Jesus Camp 
 
 	 The Lost City 
 
 	 Painted Skin -- The Resurrection 
 
 	 The Thieves 
 
 	 Dumbstruck 
 
 	 Countdown to Zero 
 
 	 Vengeance of an Assassin 
 
 	 Skating to New York 
 
 	 I Wish 
 
 	 Commitment 
 
 	 Into the White 
 
 	 The Assassin 
 
 	 A Place at the Table 
 
 	 Venus and Serena 
 
 	 Grand Piano 
 
 	 FrackNation 
 
 	 And While We Were Here 
 
 	 Swelter 
 
 	 Legendary Amazons 
 
 	 Good Ol' Freda 
 
 	 The Truth About Emanuel 
 
 	 A Long Way Down 
 
 	 Great World of Sound 
 
 	 Muay Thai Giant 
 
 	 Ocean Heaven 
 
 	 Ballet 422 
 
 	 The Good Heart 
 
 	 I'll Follow You Down 

 	 Big Star: Nothing Can Hurt Me 
 
 	 The Last Tycoon 
 


Of course, this isn't the only free movie content to be found on YouTube. Any savvy YouTube user can fairly easily find other content that either has snuck its way past the copyright conTROLLERS, or movies that mostly wouldn't be considered to be "top tier" productions. For example, I just typed "free movies on youtube" in the YouTube search bar, and was presented with hundreds -- if not thousands -- of choices.

 

 


Granted, many of these movies can't be described as "prime" or "top tier" movies. But, there are some hidden gems in there, too. For example, one of the movies in a collection of what's descr”ibed as 600 SciFi movies is The Last Man On Earth, starring Vincent Price. Another, as you can see in the screenshot above, is Metropolis, the 1927 classic that is touted as being one of the first -- if not the first -- SciFi blockbuster movies ever.


Do you like 1980s movies? Well, there's a playlist containing 277 movies from the 1980s, including Paternity, starring the recently departed Burt Reynolds. Do you like classic movies? There's a playlist containing 129 classic movies, including one of my personal favorites, Stalag 17. Popcornflix maintains a playlist of their mostly B movies, with 117 videos in the list. There's a list called "Rare 80s Movies" containing 112 videos, including the 1983 post-apocalyptic movie The Day After that I was actually an extra in while I was a student at the University of Kansas. If you like action movies, then you're likely to find something in this playlist that appeals to you.


Here's the REALLY great part about all of these "other" free movies on YouTube: they are free to watch, without having to endure ads. Yup! You can watch them, ad free!


No matter your interest, if you search hard enough, you're sure to find something that appeals to those interests. I do know that there are many users who will avoid YouTube like the bubonic plague, just because it's owned and operated by the evil Google empire. If that's the choice you make, then this article isn't for you. But the free movies on YouTube provide an excellent choice for those who a) want to watch some free movies, b) want to "cut the cord" (or who can't afford cable/satellite service), and/or c) those who want to avoid streaming services that might be operating in a legal gray zone (like Popcorn Time).


Meanwhile, the rest of us will enjoy the entertainment provided by the free movies.




 
 

 
 


 
 









  
Until AM: So You Think You Can Scratch?
 
 


by phorneker


In the past, I used Mixxx for mixing music and manipulating sound clips the same as a DJ does with vinyl. In recent years, I noticed that Mixxx in the repository no longer works with the updated PCLinuxOS installation.


The problem here is that Mixxx terminates with a Segmentation Fault message complaining that it cannot find a specific function in the VAMP library. Naturally, the first thing I did was to download the latest version (2.1.4) of the source code and attempt to compile Mixxx.


I found out that Mixxx will not compile under GCC 7.3 whereas it compiled under GCC 4.9, which we previously had in the repository. On another machine with Slackware pre-15 release installed, Mixxx  compiled under GCC 8.2.


So now, I am left with no choice but to replace Mixxx with another application that does the same thing. Fortunately, I came across the Until AM website in a Google search.

 

Installation of Until AM for Chrome


You will need to have the google-chrome package installed from the repository (search "chrome" in Synaptic) for any of the following to work.

 

 


Scrolling down, I discovered there are two versions of Until AM available. The first link is for the web browser based application, and the second link is the offline application that utilizes the Chrome runtime library. This article covers the latter version.

 

 


Clicking on the "Until AM for Chrome" link will take you to the Chrome Web Store.

 

 


Here, the screenshot shows the button "Launch App". This is because the application has already been installed. If this application were not installed, the button would read "Install on Chrome"


Simply click on the Install button for the crx package (crx stands for Chrome Extension) to download and install into Chrome. Once installed, Until AM for Chrome will appear in the Chrome Apps menu on Plasma 5, XFCE, MATE, and other desktops with the freedesktop.org specification.

 

 


It will also appear in the Chrome Apps page within Google Chrome itself.

 

 


Next, Launch Until AM.

 

Now that we have Until AM for Chrome installed, all we have to do is launch it. This can be done from within Chrome (the application icon should appear in the local Apps page), or from the Chrome  menu.

 

 


What we see are two virtual turntables and a sidebar where music can be sourced. Also, the layout of the controls on the second turntable is a mirror image of the layout of the first turntable.


The top of each turntable has a visual representation of the audio file that has been loaded into the virtual turntable. The clock next to the audio file represents the position in the audio file where the needle is on the virtual vinyl.


For the first turntable, the control on the left is to adjust the playback speed. The control to the right is the volume control for the turntable itself. The metallic button powers on and off the turntable. If an audio file is loaded, playback of the audio presumes that the needle is on the virtual vinyl at the time of power up or power down.


Below each turntable is a panel where audio effects are applied to the playback. Between the panels is a fader that controls the mixed output. When set to the left side, music from the left turntable becomes the audio output. When set to the right side, music from the right turntable becomes the audio output.


However, anywhere in between is where the mixing of audio from both turntables happens. Placing this in the center provides equal output from both turntables. This is where the magic behind the mix happens.


The help menu gives us this list of keyboard shortcuts. These shortcuts are useful only after you had some practice using Until AM.

 

 



Get Some Music on the Turntables



You can import music from SoundCloud, Google Drive or on your local hard drive. The SoundCloud option does not require a SoundCloud account for access, but you will need to have a Google account to use the Google Drive option.

 

 


With this option, you can load the list of files to use with locally stored files in OGG, MP3 and WAVE (uncompressed) format. While I have an extensive collection of music in my Music and samples directories, it is more fun to load files from SoundCloud.

 

 


All you need to do is to search for files the same way we search on Google (using keywords). Let us type pclinuxos into the search box and see what comes up.

 

 


Sure enough, my remix of "GIMP Image Manipulator" appears (the one with the PCLinuxOS logo), as well as a ten second sound clip (with the default Until AM logo assigned to the clip) of a voiced message indicating a missing sound URL (despite what it says in the description).


If you visit my page on SoundCloud, there is a (heavily edited) remix I did of a Donald Trump campaign speech tagged #Comedy along with a LMMS rendered version of the 1948 Duke Ellington classic "Satin Doll".

 

 


Simply drag the item with the PCLinuxOS logo on it to a turntable. (The cursor will turn into a vinyl record as shown on the graphic). The logo will appear with the image of a vinyl record embedded in the logo. You can load the same file into both turntables, or you can have a different audio file on each turntable. 

 

 


Here, the same file is loaded into both turntables. It is similar to mixing two copies of a vinyl album.


Since we can search SoundCloud for music, let us say we want to mix in a sound clip of Steve Ballmer. Here is what we get when steve ballmer is typed into the search box.

 

 


The clip from Matthew Biggs is Steve Ballmer saying "I love this company". The tongue sticking out is appropriate here. The clip with "Developers, Developers, Developers" is the one produced by Smixx. Dragging either of these will place a picture of Steve Ballmer on the turntable.

 

 


Now that we have the turntables loaded, simply press the metallic button with the play symbol to start the turntable. To scratch, move the mouse over a turntable, hold down the left button, and drag the mouse back and forth. You should be able to hear the scratching sound.


The sound emulated is similar to sounds produced with a physical CDJ unit (from manufacturers such as Pioneer), that is a hardware CD player that emulates a turntable with controls that simulate vinyl.


Releasing the mouse button places the turntable back in playback mode.


Note: A wireless mouse is recommended here as there is no wire to get in the way of audio file scratching.


For those of you who are wondering what Steve Ballmer looks like in Until AM for Chrome, I have the same setup with a Steve Ballmer track loaded.

 

 



Use PulseAudio to Record Mixes


Unless you are planning only live performances, you will want to record what you create with Until AM for Chrome. You will need to have PulseAudio installed and enabled in PCLinuxOS in order to record anything from Chrome applications or from web browsers themselves.


PulseAudio should have already been installed when you installed PCLinuxOS. If you removed PulseAudio, you will need to install the task-pulseaudio package (which will pull in all dependencies) and reboot your system for PulseAudio to be active.


Having said that, we will need to launch the PulseAudio Control Panel (with Until AM already running), which should be in the Sound menu.

 

 



Click on the button labelled PA Recorder.

 

 


Then click on Select Source Device. Until AM should already be running with the window in the background.

 

 


The proper item should already be selected as Until AM outputs to the Monitor of Built-in Audio Analog Stereo. (This selection is for a Hewlett-Packard Compaq 8510p laptop.)


Click on Select Highlighted Entry and Close this Window.

 

 


Now, we need to specify the name of the file where the recording will be stored. Click on Select Output Filename.

 

 


Recordings will be stored in the PulseAudioRecorder directory in your home directory. Click on the pencil if no files are showing.


You may store files in MP3, OGG, FLAC, MP2 or WAVE formats. I use the WAVE format as the stored audio is uncompressed (and hence tends to work faster than storing audio files with compression). Click on OK when finished.

 

 


Now we are ready to start recording our projects. Click on Start Recording, then click on the Until AM window to bring the DJ console to the front.

 

 


When finished, bring the Pulse Audio Recorder window to the front and click on Stop Recording. It is easier when you run Until AM from Plasma 5, XFCE or MATE as you will be able to bring the recorder window to the front by selecting it from the panel.




 
 

 
 









  
Alternatives To Dropbox, Part One
 
 



by Alessandro Ebersol (Agent Smith)


 


As of August 10, 2018 most users of the Dropbox desktop application of all Linux distributions have received notifications that their application will stop synchronizing files from November.


The Dropbox support statements state that the only supported Linux file system for sync folder storage, as of November 7, 2018, will be on a clean ext4 file system. This means that Dropbox will drastically reduce Linux support, since almost all Linux distributions have other file systems as their default installation standards today - not to mention the encryption performed on an ext4 file system, which does not qualify as a clean ext4 file. That is eCryptfs, which is the default, for example, in Ubuntu for encrypted folders, will not be supported. So far, Dropbox has been supporting Linux platforms since its services started in 2007 with no restrictions on the file system format.


The requirements for running on Linux have changed as follows:


 	 Ubuntu 14.04 or higher, Fedora 21 or higher.

 	 You should have glibc 2.19 or higher.

 	 The Dropbox folder will need to be on an ext4 hard drive or formatted partition.

 	 Caution: ecryptfs is not compatible, but Dropbox will continue to synchronize with compatible file systems that use full disk encryption (for example, LUKS).

 	 If your device does not meet these requirements, you can still use the Dropbox desktop application as long as it meets our system requirements for Dropbox on Linux (but remember that your results may vary).



Hence, Dropbox will no longer support Linux in its entirety, which may determine its retirement for many Linux users, and possibly in PCLinuxOS. So, I will introduce some alternatives to the service, remembering that there are more alternatives even than those I'll present in the article(s) that follows.

 

Mediafire

 

 


Mediafire site splash screen
 

Mediafire is the simple solution for uploading and downloading files on the Internet. It focuses on providing a positive experience for users of downloads, but does not offer an affiliate program for the uploaders.


Files hosted on MediaFire can be accessed directly. There is no wait time to start a download, and there is no limit to the amount or frequency of download. Several files can be downloaded simultaneously.


Pros and Cons


 


URL: https://www.mediafire.com/
 
Located in Magnolia, Texas, USA.

 

pCloud

 

 


Desktop application splash screen
 


pCloud is a free cloud storage service that offers 10 GB of free space. Certain conditions, once met, can increase it to 20 GB without cost.


Share folders and files with anyone, copy social media photos to your account, and manage everything with a mobile app, through a web interface and using a client program.


Anyone who signs up with pCloud instantly gets 10 GB of free storage.


There are numerous things one can do to gain more free space, such as: invite friends to make their own accounts and like the pCloud Facebook page.


A total possible space of 20 GB can be used for free with pCloud after all the bonus options.

 

File sharing with pCloud


There are two ways to share pCloud folders.


The first is for public access. You can create this type of link for any of your files, both on the site and in the pCloud mobile application. The application allows you to send these links to others by SMS, email, Twitter and Facebook. Recipients do not need a pCloud account to open these types of links, and can even download all files in ZIP format.


You can also invite other pCloud users to view and access a folder in your account. You can allow the recipient to read, create, modify, and/or delete access to the folder. This type of folder sharing can be started on the site, in the desktop program, and in the mobile app.


There is another way to share folders with recipients, but it's a bit different from the common method. Instead of sharing the files in the folder, you are sharing the folder space. This means you can create a link to one of your folders to make it publicly accessible, allowing anyone to upload files to your pCloud account. This is a bit like the Mediafire FileDrop feature.


You must set the maximum number and size of files that can be uploaded to this type of folder, which is ideal to prevent your account from being filled with public files, uploaded by others.


When an upload folder URL is created, a unique email address is also displayed to the public when you access the page, which can be used to send files directly to the account via email.


While folder sharing has the above options, the files2 can only be shared one way, which is with the public (unregistered users). Shared file URLs can be shortened to a small link for easier retrieval.

 

Pros and Cons

 

 


URL: https://www.pcloud.com/

Located in Switzerland, Europe.

 

Cozy.io

 

 


Cozy Cloud website splash screen
 

Cozy Cloud is a service of Cozy, a French startup that wants to completely rethink how cloud services work. Initially, the company launched a Dropbox competitor to store, sync, and share all of your files (the Cozy drive). Now the company wants to take a step further and create an ecosystem of open source services that respect your privacy.


Cozy's scope is ambitious because it wants to be central command of the user's digital life, an all-in-one of what you do and live online.

 

 


Soon after signing into the Cozy service, and when logging in for the first time, a screen with the selection of various services will be displayed, as the picture above.


The free subscription entitles you to 5 GB of storage. The storage is total, divided between your files, documents and photos. Plans start with 50 GB of storage, for € 2.99 a month, and 1000 GB for € 9.99 a month.


The services, which can be connected to your account, increase by the day: Banks, ISP's, electricity companies, cable TV, in short, all the services of these companies can be "connected" to your Cozy account, and Cozy cloud becomes a central hub, from where you can interact and control all these services (energy bills, cable TV, homebanking, etc ...)

 

 


The basic applications are Cozy Banks, Cozy Drive and Cozy Photos. These are already enabled to you when you sign up for the service.


Cozy Banks is a hub for home banking in one application. Place all the banks where you're a client in that application, and access your home banking through it.


Cozy Drive is the equivalent service to Dropbox, and what we are interested in this article. Cozy Photos is a service to publish your photos, similar to Picasa and Flickr.

 

Pros and Cons

 

 


URL: https://cozy.io/
 
Located in France, Europe.


I have introduced these first three services, which offer good support, both for Linux and PCLinuxOS. In another opportunity, I will address other services, and an exclusive one for PCLinuxOS users, PCLOS-Cloud.


I hope you enjoyed it, and, until next time, with more online storage services.
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The Best Audio (Codec) You Probably Haven't Heard
 
 



by Jabari Zakiya

                
Just about everybody who plays music has heard about (and uses) MP3 or WAV audio files. If you're into open source you probably know about (and may use) Ogg. If you're really an audiophile, you use FLAC to rip and store your music. But there's a new (since 2007) audio codec that beats all other lossy codecs, and can even give FLAC a run for its money if file size is important. It's called Opus. Here's its overview on its homepage.

 

 


Opus is a totally open, royalty-free, highly versatile audio codec. Opus is unmatched for interactive speech and music transmission over the Internet, but is also intended for storage and streaming applications. It is standardized by the Internet Engineering Task Force (IETF) as RFC 6716 which incorporated technology from Skype's SILK codec and Xiph.Org's CELT codec.


As an IETF internet standard, Opus encoded audio plays automatically in most major modern browsers (Firefox/Tor Browser, Chrome/Chromium/Slimjet, Opera, Edge), and music players (VLC, Audacity, Clementine). For more detail, there's an extensive FAQ, https://wiki.xiph.org/OpusFAQ, and listening test examples -- https://opus-codec.org/examples/


It's available in the PCLinuxOS repos under opus-tools, which provides a command line opus encoder, opusenc, which the documentation states will encode WAV, AIFF, FLAC, Ogg/FLAC, or raw files. To use just do: $ opusenc <filename> and a <filename.opus> file will be created in the same directory. If you're adventurous, you can play around with a host of encoding parameters to suit your fancy.


From personal experience I can attest to its compression superiority. Here is an example of file sizes that were produced encoding a WAV file with various codecs using their default settings.

 

 


Being an IETF internet standard, you probably don't realize it's what's being used by you're streaming service, or WEBRtc app, or gaming platform. There's also a site of free Opus encoded music you can listen to here, http://opus1.o1engine.com/.


If you'd like higher quality audio AND much smaller file sizes too, give Opus a try.




 
 

 
 


 
 


 
 









  
Short Topix: Berners-Lee Seeks Web Reset
 
 



by Paul Arnote (parnote)


 



Two New Gmail Bugs ... In ONE Week!


Developer Tim Cotten disclosed not one, but TWO new Gmail bugs in one week on his blog in November.


The first Gmail bug was discovered when he was able to surreptitiously place items in a Gmail user's Sent folder without their knowledge. From his blog entry about the discovery on November 13, 2018:


A strange thing happened to an employee today, who prudently came to me concerned their Google Apps Gmail account had been compromised by an external party.


Upon questioning they explained that they had checked their Sent folder with the "in:sent" filter and discovered several emails they had no memory of sending supporting a local political party.


Recognizing that this could indeed be a very legitimate threat to our corporate infrastructure we moved to diagnose and resolve as quickly as we could, and what we found was quite surprising: the emails had not been sent from her account, but were received from an external account and then filed in her Sent folder automatically.


Well... kind of.



Using the Linux email program mutt, coupled with sendmail, Cotten was able to send an email that was automagically filed in the recipient's Sent folder. Simply by placing the recipient's email addresses in quotes in the "From" field, the sent email appeared in the recipient's Sent folder, as if they had sent it to themselves. As he observantly and rightly points out, the RFC 2822 3.6.2 standards for email prohibit this kind of activity.


This Gmail "hack" can cause considerable problems for unsuspecting users, and is ripe for exploitation. Despite due diligence by users, all it takes is one or two of these exploits to slip through the cracks -- which seem to be growing ever wider and wider -- to wreak havoc on a user's system, or even worse, across an entire network of enterprise users.


Ah, but Cotten wasn't finished yet.


In his November 16, 2018 blog entry just three days later, he revealed how easy it was to almost completely mask the sender's identity. To the average user, no sender appears. Hitting the "Reply" option doesn't help, either. Gmail just can't figure out what to do.


Just by manipulating the "From" field to include an <img>, <script> or <object> tag causes Gmail to leave the "From" field empty, as far as the user interface is concerned. A glance at the raw email data (accessible in Gmail by selecting "Show original" from Gmail's three-dot menu on each email) will show the sender information at the end of the tag used to obfuscate the sender. But the Gmail user interface can't seem to find or parse that information.


This newest Gmail bug is the worse one of the two. It gives phishing scammers a brand new vector that leverages the Gmail user interface's shortcomings. The email headers are fine and intact. But Gmail's user interface cannot properly parse that information.


Cotten reported both bugs to Google, but has yet to hear back. Nope. Nothing but a chorus of crickets. Subsequently, when he reported the information on Hacker News, reports of other Gmail hacks and bugs poured in. To say the least, it makes for some interesting reading, especially if you are a Gmail user.


If you were worried about the security of your Gmail account from the three and four letter government agencies, you now have even more to worry about.

 

 


Russian Hackers Targeting US, Europe With New Malware


File this one under "be glad you use FOSS/Linux and open source office productivity software."


New malware from Russian government-sponsored hacking groups has been spotted in circulation, according to a TechRepublic article. As you might expect, it targets Windows users in the U.S. and Europe. According to the article, the malware is being "actively distributed by Sofacy - their codename for Fancy Bear, a group also known as APT28, a hacking group which is with strong links to the Kremlin."


Called Cannon, after a name reference in the malware code, it takes a screenshot of the infected user's screen every 10 seconds, and gathers full system information every five minutes. The collected information is then emailed in the background to email accounts in the Czech Republic controlled by the hackers.


This latest malware sends an email about a recent current event (the one where the malware exploit was discovered was about the Lion Air crash in Indonesia). There is an attached Microsoft Word document. When the user attempts to open the document, they are told that the document was created with an older version of MS Word, and macros need to be enabled in order to view it. That starts the process for installing the malware package. To help avoid detection, the malicious code isn't activated until after MS Word has been closed.


Once activated, the malicious code contacts a "command and control" server run by the attackers, and the malware is then downloaded and activated.

 

 


Web Creator Sir Tim Berners-Lee Envisions A "Web Reset"


"The Web as I envisaged it, we have not seen it yet. The future is still so much bigger than the past." -- Sir Tim Berners-Lee, creator of the World Wide Web.


Are you tired of Microsoft, Apple, Amazon, Google, Facebook, Twitter and all of the other big tech companies holding your personal information hostage for their own benefit? If so, you're in exquisite company. Sir Tim Berners-Lee is, too.


The web -- as in World Wide Web -- that we have today is NOT the web that its creator had envisioned when it was released (freely) to the world 28 years ago. Yes, THAT "web" that permeates so many facets of our daily lives today. In fact, Sir Tim Berners-Lee says "I was devastated" in a Vanity Fair article from July, 2018, as he watched his creation become rather distorted from the vision he had when he created it. You can view the very first webpage ever, here.


Berners-Lee writes on his blog:


I've always believed the web is for everyone. That's why I and others fight fiercely to protect it. The changes we've managed to bring have created a better and more connected world. But for all the good we've achieved, the web has evolved into an engine of inequity and division; swayed by powerful forces who use it for their own agendas.


Today, I believe we've reached a critical tipping point, and that powerful change for the better is possible -- and necessary.

This is why I have, over recent years, been working with a few people at MIT and elsewhere to develop Solid, an open-source project to restore the power and agency of individuals on the web.



So what are the things that have "devastated" him? Recent data breaches, spying on users, collecting user data for financial gain are some of the things that have forced Berners-Lee to attempt a "web reset" with the release of Solid.



So what is Solid? Here's the description from Solid's "About" page:


Solid is the technology that underpins a movement, being lead by Sir Tim Berners-Lee to re-orient the web to its original vision.  To understand the ‘why' of Solid, it's important to understand the evolution of the web and how it's diverged from Sir Tim's original and inspiring vision.


The first web browser was also an editor. The idea being that not only could everyone read content on the web, but they could also help create it. It was to be a collaborative space for all mankind.


However, when the first browser that popularized the web came along, called Mosaic, it included multimedia and editing was taken out. It was considered too difficult a problem. This change was the first curtailing of the web's promise and spawned an effort lead by Tim and others to get the write functionality back. It was dubbed the ‘read-write web' and lead to Richard McManus' seminal article published in 2003.


Solid has taken 15 years of development work to finally deliver this.


The issue with writing data, as wikipedia and others have learned, is that you need a degree of control over who can write what. That means you need to have permissions - what can individuals do to the data. And to have permissions you need to have a system for identity - a way of uniquely confirming that an individual is who they purport to be.


At the same time the web was always designed to be a space for data as well as documents. The Linked Data Platform group formalized this further by creating a standard for working with file systems, which when combined with the Unix philosophy form a powerful way of achieving this. These two principles, of read-write capability and managed data accessibility are key to the original and potent concept of the web. They were unfortunately lost along the way as the web evolved.


Hence solid, based on existing web standards and the result of decades of work, Solid has read-write functionality, incorporating permissions and identity, along with data manageability and real-time updates via a websocket.


It realizes the web as originally envisioned and provides a platform for the next generation of truly empowering and innovative applications.



With Solid, USERS decide who has access to their data. USERS keep their data safe, stored in a place THEY decide. It could be in a file on your computer, or it could be on a USB flash drive. Whenever another application wants or needs your data, the USER decides who gets access and how much access.


In a way, Solid is the "read-write web" that Berners-Lee envisioned 28 years ago. But it goes further than that, by empowering users with control over their data -- personal and otherwise.


After suffering through endless mass data collection by companies like Google, Facebook, Apple, etc., and the data breaches that occur almost daily across the web, Solid sounds like not only ambitious, but also a HUGE breath of fresh air. FINALLY, someone has rode into the apocalyptic web landscape like a knight on a white horse. Ironically, that someone is Sir Tim Berners-Lee, the very man who invented the whole idea of the World Wide Web, to set it back on track to preserve his vision of what he set out for it to be.


It's about time someone did something.

 

 


Linux Getting Two-Line Patch To Finally Deal With The Quirky Microsoft OEM Mouse


Despite all of Microsoft's "love" being professed for Linux, the Microsoft OEM mouse has remained a thorn in many Linux users' side for several years. That is, until now.


According to a phoronix.com article, the Microsoft OEM mouse worked just fine from Linux kernel version 2.6. But, in 2012, with kernel 3.4, something "broke." The mouse would freeze every 60-62 seconds use under level 1 or level 3. The mouse is also sold as a Dell mouse, with the model MS116.


Linux identifies it as a PixArt mouse. We're not talking about some high end gaming mouse, either. This is a very, very basic USB mouse, that typically sells for between $5 and $7 (U.S.). Therein is where the problem lies. The Linux driver USBHID is responsible for managing USB devices, including USB mice. The mouse will "freeze" because it was not polled, and experienced a buffer overrun.


Finally, the two line "fix" is being rolled into the Linux kernel, thanks to SUSE developer Sebastian Parschauer. It is also being backported into the series of stable Linux kernels. He also posted the issue on GitHub.


If you can't wait for the fix to hit the kernel, you can also use a kernel boot option to fix the quirky behavior. Add usbhid.quirks=0x413c:0x301a:0x00000400 to your Linux boot options. The 0x413c is the vendor id (PixArt), and 0x301a is the device id. The 0x00000400 tells USBHID to always poll the device.


The problem isn't necessarily unique among USB mice. Logitech and Corsair mice also needed this workaround, but they were addressed in a more timely manner. For whatever reason, the issue with the Microsoft OEM mouse was never addressed. As he states in his GitHub entry on this issue, "PixArt mice with this HW issue are known from vendors Chicony, Dell, HP, Microsoft, PixArt, and Primax."

 

 


It's possible that you have another mouse from another vendor that experiences similar issues. To see the information about your mouse, open a terminal session and enter lsusb -v at the command line. Scroll through the information until you find your mouse.


Write down exactly the idVendor and idProduct identifiers. Then, plug them into the usbhid.quirks kernel boot option. Using the screenshot from my own computer (above), the boot option would be usbhid.quirks=0x1bcf:0x0535:0x00000400. For what it's worth, you can chain up to four USB devices in the Linux boot option command, each separated by a comma.


So now, if you have one of these basic mice lying around, you should now be able to use it without difficulties, and without it "freezing up" on the screen.

 

 


Make Your Android Phone Or Tablet  Feel Twice As Fast With This "Secret" Setting


If you have an Android smartphone or tablet, you know how fast the latest, greatest device becomes yesterday's news. There are new processors, new phones and new versions of Android being released all the time. Last year's top performing device will be obsolete this year. The problem is, because of their high cost, most people can't afford to upgrade their device any more often than once every two years, in most cases.


So, what to do with last year's model that now feels slow? Well, the bgr.com website recently ran an article showing how to make your older Android phone feel a lot faster. Indeed, the bgr.com article was specifically about Android phones. However, I pulled out my inexpensive RCA 7-inch Android tablet, and this "trick" works with it, as well. Your mileage may vary, but I reckon that it should apply to most any fairly recent Android device.


One thing that has a HUGE impact on the performance of your Android device is the speed of animations as your device transitions from one screen to another. What this "secret" setting does is double the animation speed.


Your Android screen is full of animation transitions. You see them when you open an app, close an app, open or close popups, or even when you switch between apps. Fortunately, the change is very, very easy to make. Most recent versions of Android should work.


Go to the Android Settings app. Select "About phone" on your Android phone, or "About tablet" on your Android tablet. Scroll down to Build number, and tap it seven times. This will enable the hidden "Developer options" menu. Yes, it is hidden from your view until you jump through these hoops.


Now, go back to the top level window in the Android Settings app, and you will be greeted with the new "Developer options" menu. Select it, and scroll down to find these three items:


 	 Window animation scale

 	 Transition animation scale

 	 Animator animation scale



Next to each item, you should see a "1X" next to each of them. This means that the animations are being played at normal, 100% speed. Click on them, and you will see other options. Select the option that says ".5X" or "0.5X" from the list (be careful to NOT select "5X", which will slow your device down dramatically!). The ".5X" means that the animations will be played in half the normal time, or twice as fast.


Now, you older Android phone will go from feeling sluggish to feeling brand new. If you have a newer Android phone, even if it isn't a "top of the heap" model, it may just feel as if it is.

 

 


The Linux 4.20/5.0 Kernel Is The Biggest All Year With 354+ Thousand Lines Of New Code


The phoronix.com website reported that the Linux 4.20~5.0 kernel is the biggest of all year, with over 354,000 lines of code. The merge window closed on November 4, 2018, with Linus Torvalds expected to release the first release candidate either later that day, or very soon after.


Despite shrinking the lines of code in the kernel by over 400,000 lines between 4.18 and 4.19 kernels, the 4.20 kernel now expands it. The reason the 4.18 and 4.19 kernels shrunk was because old architectures and staging drivers were dropped from those kernels.


If you're curious about what is coming with the new 4.20 kernel, you can check here to see all the coverage phoronix.com has given to the new kernel and its new features.


The new 4.20~5.0 kernel is expected to be released as stable around the end of December or in early January.




 
 

 
 


 
 


 
 


 
 


 
 







[image: Facebook Fan Club and PCLinuOS Magazine] 







  
Inkscape Tutorial: Snowflakes And Christmas Trees
 
 



by Meemaw


I found a tutorial the other day that I thought was really fun! When we are finished, we will have a pile of snowflakes plus a decorated tree. We'll do the snowflakes first.


Using the Pen tool, draw a vertical line. Make the Stroke 8 or 10 with a Square cap.

 

 


Draw a V shape similar to what is below. Make sure you center it on the first line, then group the two shapes using Object > Group or the Group button on the toolbar..

 

 


We're going to duplicate this object several times to make our snowflake. Remember, the rotate tool is shown when you click on an object a second time. Make sure you move your center of rotation to the bottom before you start.

 

 


With the object selected, choose Control+D to duplicate it, then grab a rotation handle, and hold Control as you rotate to snap the angle.

 

 


Repeat this duplicate/rotate method until you have a full snowflake shape. It can have 6 "sides or eight. Select all pieces and group them together.

 

 


You can simply change these to white (or really light blue) and duplicate your snowflakes to make a background. You can add a blue rectangle to the background as well.

 

 


When you finish that, select all of them and move them aside. This is also a good time to save your work, if you haven't done so already. We'll make the tree now.


Select the Polygon tool and choose the Star shape. Now, change your settings to the following: Corners - 3, Spoke Ratio - .380. Hold the Control key down while you drag to create this triangle shape. Fill it with a green color.


With the triangle still selected, click on Path > Object to Path to create some nodes. Choose the Nodes tool and select the middle nodes on all sides, then click Make nodes symmetric.

 

 


This curved the paths and will allow you to adjust them to look more like a tree. You want to pull the bottom down and the sides out a bit.

 

 


We're going to create a shadow. First, duplicate (Control+D) the triangle shape. Then, using the Pen tool, draw a simple curved line over this new triangle. Select both the triangle and the line, then choose Path > Division to make the cut.

 

 


You should end up with two shapes -- grab the shadow shape on the right and delete the rest. Change the color to a darker green to make it look like a shadow.

 

 


Position the shadow shape over the original triangle (using Object > Align and Distribute to align the right sides will make this much easier). It will be easier to work with if you group these two pieces together.

 

 


We've created our tree part, so now we can duplicate it at least twice, resize, and position the three or four pieces for our tree. As you go down, make each piece larger (since trees are smaller at the top) and put the lower ones behind the upper ones. Now, use Align & Distribute to center all the tree parts, then group them. 

 

 


Now, select the Rectangle tool and draw a small, brown, rectangle for the tree trunk. Click on Path > Object to Path to adjust this rectangle so it looks more like a tree trunk. 

 

 


We will need to create a shadow for the tree trunk, just like we did on the tree. Draw your line over the duplicated tree trunk, click Path > Division, and change the color of the one piece. Position it under the tree, so it looks like it should.

 

 
 


 


This is optional, but I'm going to draw a pot to put the tree in. Draw a couple of ovals over each other with the Ellipse tool. Click Object to Path on both of these.


To make the pot shape, select the Nodes tool, select the side and bottom nodes on the bottom ellipse, and then click Add nodes. You will get another node in between each of the ones you selected.

 

 


Select the three bottom nodes, click on the center one, and drag them down to create the pot.

 

 


Just like we did on the tree and trunk, duplicate the pot and create the shadow.

 

 


Position the pot, tree and trunk and group them all.

 

 


This tree needs some ornaments. Click on the Polygon tool again and change your settings to a 5 pointed star with a spoke ratio of .550 and .140 rounded, filled with yellow.

 

 


Now for some round ornaments. Create a red circle and a white oval for a reflection.

 

 


Again, we will put a shadow on the ornament. Do it the same way as above.

 

 


To be a little more realistic, we'll need a shadow behind the ornament on the tree, using the same shadow color as we used on the tree. In this case, it's just as easy to draw a circle the same color as the tree shadow, duplicate and place behind the ornaments that need shadows.

 

 


When you are finished with the tree and ornaments you can always group the whole bunch.

 

 


All that's left to do is add your snowflake background to finish the scene. I also added a drop shadow to the tree. I think it looks great! It was fun as well!

 

 


You can get a lot more creative with the snowflakes, but I'll let you play with that yourself. 


Have a Merry Christmas, or whatever holiday you celebrate this time of year.




 
 

 
 


 
 









  
PCLinuxOS Family Member Spotlight: iceman
 
 



As told to YouCanToo


 


What is your name/username?

Marcos Morais/iceman.



How old are you?

34 years old.



Are you married, single?

Married.

 

 


How about Kids, Grandkids (names and ages)?

I have one kid: João Pedro 12 years old.

 

 


Do you have pets, what is your favorite?

Yes, my favorite is a dog with name: Meg.

 

 


Are you retired, still working and if working, what do you do?

I'm working. I'm a developer and TI Analyst.



Where do you call home? What is it like? IE: weather, scenery

What I call home is a place where I can enjoy with my family finding balance, peace and joy. If I could describe a place, it would be a house in the mountains with a beautiful view, and of course, a place to be connected in PCLinuxOS.  My city is Espumoso/RS Brasil.

 

 
 


 
 


 
 


 


Where did you go to school and what is your education level?

I studied in colleges here in Brazil. I have Graduation in TI Analyst.

 

 


What kind of things you like doing? hobbies, travel, fishing, camping?

Hobbies, ride a bike, play video games with my son.

 

 


Why and when did you start using Linux?

I started in the year 2006. I realized the importance of an open system code and what it could evolve.

 

 


What specific equipment do currently use with PCLinuxOS?

Laptop Acer Aspire ES 15

 

 


Do you feel that your use of Linux influences the reactions you receive from your computer peers or family? If so, how?

This guy is a nerd. What's in his head?



What would you like to see happen within PCLinuxOS that would make it a better place. What are your feelings?

I believe that PCLinuxOS already has the best place of all, as it contemplates a rich and functional system. My feelings are grateful that PCLinuxOS exists and is constantly learning.


 
 


PCLinuxOS Family Member Spotlight is an exclusive, monthly column by YouCanToo, featuring PCLinuxOS forum member. This column will allow “the rest of us” to get to know our forum family members better, and will give those featured an opportunity to share their PCLinuxOS story with the rest of the world.


If you would like to be featured in PCLinuxOS Family Member Spotlight, please send a private message to youcantoo, parnote or Meemaw in the PCLinuxOS forum expressing your interest.





 
 








  
Repo Review: Cool Retro Term
 
 



by CgBoy


This month I'll take a look at Cool Retro Term, a customizable terminal designed to replicate the look of old CRT computer screens. It has a curved screen, an old monitor frame, noise, flickering, jitter, and other effects all to make it look like an old computer terminal. As always, it can be found in the PCLinuxOS repository.

 

 


You can manually configure how the terminal looks, or choose from the default profiles it comes with, such as "Vintage", "Apple ][", "IBM Dos", and more. My favorite profile was "IBM Dos". Like I said, you can also manually configure it to your liking, and you can create custom profiles of your configurations.

 

 


You can set it to use scan lines or pixels, change the brightness, contrast, and opacity of the terminal, and you can add or remove the frame around it. There are a variety of fonts that can be set, including those of a few vintage computers. You can also change the font and background colors.


All of the many effects in Cool Retro Term can be adjusted individually. Cool Retro Term can be run in fullscreen mode, and if you find the menubar ugly, you can hide it.

 

 


Summary


Although I like Cool Retro Term, I do find some of the profiles a bit painful on my eyes, so I will most likely just keep using Konsole as my main terminal. But, if you like retro computers and CRT monitors, this fun terminal certainly worth trying.




 
 

 
 


 
 









  
ms_meme's Nook: The Twelve Days Of Linux
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PCLinuxOS Bonus Recipe Corner: Dijon Chicken Smothered In Mushrooms
 
 





Dijon Chicken Smothered in Mushrooms




INGREDIENTS:


4 boneless skinless chicken breasts (about 1 lb)

1/4 cup All-Purpose flour

1/2 teaspoon salt

1/4 teaspoon pepper

2 tablespoons olive or cooking oil

1/2 cup roasted garlic-seasoned chicken broth (from 14-oz can)

1 jar (4.5 oz) sliced mushrooms, drained

1 1/2 tablespoons Dijon mustard

Chopped fresh thyme, if desired

 

DIRECTIONS:


1. Between pieces of plastic wrap or waxed paper, place each chicken breast smooth side down; gently pound with flat side of meat or rolling pin until about 1/4 inch thick. In shallow pan, stir together flour, salt and pepper.



2. In 12-inch nonstick skillet, heat oil over medium-high heat. Coat both sides of chicken with flour mixture. Cook chicken in hot oil 6 to 8 minutes, turning once, until chicken is no longer pink in center. Remove chicken to serving plate; cover to keep warm.



3. Stir broth into skillet. Heat to boiling over medium-high heat. Stir in mushrooms and mustard. Cook 2 to 3 minutes, stirring frequently, until slightly thickened. Spoon sauce over chicken. Sprinkle with thyme.

    
TIPS:


For a meal that's sure to satisfy, serve this saucy chicken dish with a small baked potato, cooked green beans and 1/2 cup cut-up fresh fruit. Add a slice of bread, and you're still at only 3 Carbohydrate Choices.


Try this recipe with pork tenderloin. Cut the tenderloin into 1-inch slices, and flatten as directed in step 1. Continue as directed, cooking until pork is no longer pink in center.




 
 








  
Testimonials!
 
 



Compiled by Meemaw


Everyone loves to see compliments, and we here at PCLinuxOS are no different. Our Testimonials section is there for just such compliments. Here are a few we've seen lately, which proves yet again that ours is the best distro, because it works.

 

From phylades81


I read this site and replied to a Mark Jacobs (team Leo):

https://askleo.com/microsoft-we-deserve-better/?awt_l=4PiP8Y&awt_m=I_8NflC8NpdfbL&utm_source=newsletter&utm_campaign=20181030&utm_medium=email&utm_content=featured


MY reply:

Possibly over 3 years ago I worried about Windows with my capped mobile data. You mentioned that Linux, possibly Mint, could be the solution. I only started using a computer in 2003 and am now 83, but nevertheless, I stumbled onto PCLinuxOS. Sure, it's been a learning curve. But now, with KDE Plasma 5 it works so well that it's almost boring. Early on, their forum got me through many hoops, many times. Lately though, I use it the odd time to help find an app in the repository. I've had replies come back in minutes. I still have Windows 7 on another drive, never on line, mainly for my wife's Photoshop. Also, PCLinuxOS is on my Latitude Laptop. It's as if I had been cured of chronic headaches.

 

 


From willbeprog127


I've had a rather long and sometimes frustrating journey through free operating systems throughout the years. I demand much from my operating system, because I need it to be reliable, easily configurable, and consistent from day to day.


An operating system simply isn't something I use to browse the web or send e-mail. I also use it to help the few customers I have left after many years of providing remote support for them. Even though my business is almost non-existent at this point, I still need to render assistance immediately, and not waste a bunch of time getting my OS to cooperate with me. This is where PCLinuxOS shines!


I've used Mandrake, Debian, Ubuntu, Mageia, Slackware, Puppy, Knoppix, Artix, AntiX, CentOS, RHEL, Calculate, OpenMadriva, Fedora, openSUSE, LinuxBBQ, Trisquel, Devuan, Mint, Arch, Sabayon, Salix and many other Linux distros. I've also used Haiku, ReactOS, OpenIndiana, FreeBSD, NetBSD and NetBSD. And of course I've used -- (sigh) -- Windows. But you know what? Out of all of these, PCLinuxOS has been the only well-supported and reliable non-systemd Linux distro I've had the pleasure of using.


Missing package? You guys add it (almost) without fuss. I need help with something on the forums? You guys come running to help, and you don't even know me. Most of you all treat me (and others) with a great deal of respect. That really means a lot to me, and makes me grateful to have found PCLinuxOS and all the helpful folks here. A HUGE "THANK YOU!" 


I do try to help a select few other distros by testing their wares and reporting bugs, but at the end of the day PCLinuxOS is the one I boot into to relax and read, to actually get stuff done and to write bug reports for the other distros when they've crashed.


So Tex and the gang, thank you so much! Keep up the excellent work, and thanks for making a non-systemd distro that's reliable, safe, and runs so good it's almost boring! 

 

From dickey601


I know this is not the place for this post but, I gotta post it.


I've been a PC user since 1982 (IBM PC's) and an exclusive PCLinuxOS user since 2007. I'm not an operations guy. I'm just a user, and I have relied on you (the PCLinuxOS team that responds in the forum) in every instance, dealing with issues way over my head in order to keep my little puters working for me.


You guys are amazing. Giving so much of your time and effort to help people with their issues is noble and rare these days. You are bombarded daily with people hungry for your advice. It must feel like a female dog with six teats and twelve new pups. Yet, you seem to always take time to respond even though it sometimes appears to test your patience. And it is refreshing to see a little humor injected occasionally to calm some tensions among the parties. Patience and understanding on both sides equals resolve.


Keep up the good work you guys and THANKS for the freely giving.

 

From rogerwilco


Hi everybody,


Just want to say I'm very happy with my installation and hope to remain so for many years. I'm retired now, and have a lot of time at my hand to explore different Distros (just out of curiosity, there's no thought to switch). I haven't seen one yet to match. Already early in the '90s, I grew weary of MS and went with OS/2 for as long as it lasted. Then followed quite a few years of suffering under Winwhip, until I finally ran into PCLinuxOS in the late 2000's, and it only gets better.


I've visited the forum a couple of times before in order to get help, which I eventually mostly got. Myself, I'm not a great Forum contributor; although I don't spend a lot of time here, if I see a question where I think I can be of help, I'll gladly do so.


Greetings from Sweden!



 
 

 
 


 
 









  

PCLinuxOS Puzzled Partitions
 
 


Scrappler

 
 

 
 

 
  Download Puzzle Solutions Here!
  
 
 


Sudoku

 
 


 
  Download Puzzle Solutions Here!
  
 
 


Crossword

 
 

 
 

 
  Download Puzzle Solutions Here!
  
 
 


WordFind

 
 

 
 

 
  Download Puzzle Solutions Here!
  
 
 

 
Cryptograms

From the computer of ms_meme: 

Everyday I work the daily crosswords and cryptograms in the paper. I like the cryptograms as they are wise/silly sayings of famous people. 

The magazine article about secure passwords made me think of the cryptograms. We have people in the forum who are always posting famous/wise/silly sayings. 

I have made a few into cryptograms, and hope our readers will enjoy them. 
 


 
 

 
  Download Puzzle Solutions Here!
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Posted by francesco_bat, November 3, 2018, running fluxbox
 
 
 


 


Posted by jogurtmen, November 17, 2018, running Mate
 
 
 


 


Posted by luikki, November 24, 2018, running KDE
 
 
 


 


Posted by Mr. Cranky Pants-YouCanToo, November 1, 2018, running KDE
 
 
 


 


Posted by Meemaw, November 23, 2018, running Xfce
 
 
 


 


Posted by Onlyhuman, November 4, 2018, running e23
 
 
 


 


Posted by parnote, November 3, 2018, running Xfce
 
 
 


 


Posted by Ramchu, November 5, 2018, running KDE
 
 
 


 


Posted by tbschommer, November 3, 2018, running KDE
 
 
 


 


Posted by tuxlink, November 3, 2018, running LDE
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L. July 4,2 U.S. holiday commemorating the adoption
of the Declaration of Independence in 1776,

2. holiday celebrated on the day after Christmas Day.

3. holiday in the United States for remembering the.
people who died while serving in the countrys
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4. commemorates the defeat of Hamans plot to
massacre the Jews as recorded in the book of
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5. Jewish festival lasting eight days

6. observed annually on November 11, honoring
miltary veterans.
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anniversary of the emancipation of slaves in Texas
on June 19, 1865,
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